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1 Overview

The Intel” Deluxe PC Camera and Intel Create &

Share" Software let you use your PC to communicate
in a variety of new ways.

Features include:

* Microsoft* Windows* NetMeeting* — Talk to
and see others at the same time using
NetMeeting to make video phone calls over the
Internet. For information about making Internet
phone calls, see Chapter 2 Internet Video Phone
Call and the NetMeeting online help.

+ Intel® Email Postcard — Using snapshots,
video files, and sound files you create with the
Intel Create & Share Software, you can create
email postcards and send them to family, friends,
or business associates. To learn how to create a
postcard, see Chapter 3 Using the Software.

« Intel® Home Page Builder—Construct home
pages with words, graphics, still images, and
video automatically using the supplied templates
or in a template you design. To learn how to
create web pages, see Chapter 3 Using the
Software.

* Reality Fusion GameCam SE — Use the PC
Camera to enter a virtual reality where you can
shoot baskets, pop falling bubbles, play with
bouncing objects, or enter a virtual environment
to make kaleidoscopic patterns on the screen. To
get in the action, click the PC Camera Games
icon on the Home screen. For more information
see Chapter 3 Using the Software.

« Intel® Video Email — Quickly create a video
message for sending as email. For more
information see Chapter 3 Using the Software.
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Intel® AutoSnapshot — Set up the camera to
take snapshots at regular intervals for including
on a web site, saving to your hard disk, or
sending through email. For more information
see Chapter 3 Using the Software.

Home Screen—The starting place for all activity.
From here you can access your galleries, create
new media files, and launch the video phone,
email postcard, and PC camera games.

Intel® Gallery—Organize and manage your
project and media files. From the gallery, you can
open and organize projects, video, image, and
sound files. To learn more about the gallery, see
Chapter 3 Using the Software.

Intel® Snapshot—Quickly and easily take
snapshots using your PC camera. These
shapshots can be assembled into your own
online photo galleries, printed, or sent to others
using email. To learn how to take and use
snapshots, see Chapter 2 Using the Software.

Intel® Scene Recorder — Record and trim
video clips to spice up a web page, add interest
to a presentation, or share a video of your
children with their grandparents. To learn how to
make these videos, see Chapter 3 Using the
Software.

Intel® Audio Recorder — Make audio files that
record your baby’s first words, narrate a
business presentation, or spice up an email
postcard. To learn how to make audio files, see
Chapter 3 Using the Software.

Edit Picture — Do some simple editing of still
images like changing the contrast or brightness,
rotating, or cropping the image.

Home Screen Toolbar — Reduce the Home
Screen to a desktop toolbar from which you can
scroll through the current gallery, take pictures,
make videos, download media from the camera,
and send quick video emails.
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Starting Intel” Create & Sharel
Software

From the Windows Start menu click Intel Create &
Share Software or double-click the software desktop
icon.

Online manuals

Each time you start the software you are given the
opportunity to view or print the online manuals.

» Choose the manual you are interested in,
continue without looking at any manual, or check
the “Don’t prompt to view manuals on startup” to
prevent the message from appearing again.

Running the software the first time

* The Intel Registration Wizard appears so you
can register your program. To register now,
complete the requested information. Remember
to connect to the Internet to register online.

To register later, go to:
Start >Programs > Intel Create & Share
Software > Register Online.

* An opportunity to send a Tell Your Friends
message appears. This message provides a link
to the recipient for installing Microsoft's
NetMeeting. The message also links to sites
where your friends can learn more about Intel PC
cameras’ capabilities and where to purchase
them.

To send a Tell Your Friends message later:
- From the Help menu, choose Tell Your
Friends.

The Intel” Deluxe
PC Camera
Getting Started
Guide can be
found at:

Start>
Programs>intel
Create & Share
Software>
Manual>Getting
Started Guide

Note

Be sure to
register to “Stay
in the Loop”.
Registered users
are periodically
informed of
updates,
upgrades, and
special offers.
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The Home screen

The Home screen is the starting place for all Intel
Create & Share Software activities. Following is a

picture of the Home screen and descriptions of some
of its features.
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Title/Menu bar

Full Gallery

Full Gallery (]

button
Click to expand the

gallery and see
more of your
thumbnails.

Gallery list
Click the arrow
to select

Galleries:
5 Main Gallery @

another gallery.

Gallery sorter —
Sorts your
thumbnails
alphabetically, by
date and time, or

by media file type.

Gallery

Task Icon

Edit Insert

make a video
phone call

play a PC
camera

game

Gallery

Help

visit our website...

Click here

— to minimize
send an email the Homle
postcard screen view
to a toolbar
build a
home page
F ™
Intel Create & Share
software
set up an auto
snapshot

Click any task icon
to begin that
activity.

Insert button
Inserts the selected
media file into your
email postcard.

Takei Enapsh.q!.... Rec

rd VWideo Record Audio

'\'«“.!’*

aﬁi

Home

Other Devices

Intel” Snapshot

Take a snapshot
using your PC
Camera.

Intel" SJene
Recorder

Record video using
your PC Camera.

Intel® Audio Other Devices Home icon Click
Recorder Access other devices attached to Click here anytime  here to
Make a sound your computer such as a scanner to return to the visit our
recording. or digital camera. Home screen. website.
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Click and choose
a task. Expands

the Home Screen ~— |

to full-screen.

Gallery

Home screen toolbar

The Home Screen can be reduced to a desktop toolbar
from which you can scroll through the current gallery,
take pictures, make videos, download media from the
camera, and send quick video emails.

Expands the Home Screen

to full-screen.

Click on an icon to launch the
application.

Gallery list
Click the arrow to select
another gallery.

Gallery sorter

Sorts your thumbnails
alphabetically, by date &
time, or by media file type.




The Home Screen toolbar can be positioned at the top
or bottom of the screen, or to the right and left of the
screen.

To position the toolbar on the screen:
1 Point the mouse into the gray part of the toolbar.
2 Hold down the mouse button.

3 Drag the mouse to the location on the screen
where you want to see the toolbar.
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Internet Video Phone Call

Want to test
your Internet
video phone call
capability?
Open your
browser and type
this URL:
www.intel.com/
PCcamera/
portals/
testcall.htm

Preparing for your first Internet
phone call

You can use NetMeeting* to call people over the
Internet. The person you call does not have to use
NetMeeting. Many internet phone software programs
other than NetMeeting can receive NetMeeting calls.

NetMeeting connects directly to an Internet directory
server or to another computer. To place a call, you
either choose one of the people logged on to a server,
or you call another computer by typing its computer
name or address.

Starting NetMeeting

¢ On the Home Screen click Make a Video Phone

Call.

"

Setting up the camera for calls

When you make internet phone calls, you may want to
see the other person and be seen by them. When you
start NetMeeting there is no video of you in the
window.
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To add your video to the window:

1 Onthe Home Screen click Make a Video Phone

Call.
2 On NetMeeting, click the Start Video button.

Notes

The default for video is to automatically receive video
at the start of each call.

To change this default:

1 From the Tools menu, choose Options.

2 Onthe Video tab, under Sending and
receiving video, uncheck Automatically
receive video at the start of each call.

3  Click OK until done.

To automatically send video at the start of a call:
1 From the Tools menu, choose Options.

2 Onthe Video tab, under Sending and
receiving video, check Automatically send
video at the start of each call.

3 Click OK until done.

To place a call

1 Onthe Home Screen click Make a Video Phone

Call.

2 In the NetMeeting Address bar, type one of the
following:
+ Email address.
» Computer name.
+ |IP address.

,I:'.‘Tf' MetMeeting - Mot in a Call

Cal “iew Toolz Help

myfriend@theiremail.c uma

Note:

If you have more
than one video
capture device
attached to your
computer, ensure
that you are using
the Intel Deluxe
PC Camera:

1

On the
NetMeeting
Tools menu,
choose
Options.

On the Video
tab, in the
Video camera
properties list,
select Intel
USB Video
Camerallll.

Click OK.



CHAPTER 2

Internet Video Phone Call

10

3

Click the Place Call button.

e

Notes

If NetMeeting can determine how to place the
call, it does so automatically. Otherwise, the
Place A Call dialog box opens. Then, in Using,
click the appropriate connection type.

If you select security on a call-by-call basis,
place your calls through the Place Call button
rather than the Address bar or a SpeedDial. The
Address bar and SpeedDial do not give you the
Place A Call dialog box, which displays the
Require security for this call check box.

To display a list of people you called recently,
click the arrow next to the Address bar.

You can create a SpeedDial list for people you
call frequently. From the Call menu click Create
SpeedDial.

To accept or reject a call

When someone calls you, the Incoming Calls
dialog box appears. Click Accept or Ignore.

Notes

If this is a secure call, a Details button also
appears. Click it to see the type of security and
certificate being used.

To stay logged on to the directory server, but be
unavailable for calls, on the Call menu, click Do
Not Disturb.

You also can set NetMeeting to accept calls
automatically. From the Call menu, choose
Automatically accept calls.
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To use a directory server

1 On the NetMeeting Tools menu click Options.

2 Onthe General tab, under Directory Settings,
in Directory, type or click the name of the
directory server you want to use. The default
server is the Intel directory.

Notes

» If you are not logged on to the directory server,
you can still be reached if people have your IP
address.

* If you want to log on automatically, from the
NetMeeting Tools menu, choose Options.
Select the Log on to a directory server when
NetMeeting starts check box.

» If you do not want your name and email address
to appear in the directory list when you are
logged on to the directory, from the NetMeeting
Tools menu, choose Options. Select the Do not
list my name in the directory check box.

To find someone in a directory

1 Click the Find Someone in a Directory button.

2 In Select a directory drop-down list, you will
see that Intel directory is the default.

3 To use the Intel directory, follow the instructions
on the Web page to display the list of names.

11
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Note

To find someone not in the Intel directory:
1 Click the Find Someone in a Directory button.

2 Inthe Find Someone dialog, choose another
directory from the Select a directory drop-down
list.

3 Click Close.

To log on or off a directory server

* On the NetMeeting Call menu, click Log Off
from <directory server name> or Log On to
<directory server name>.

Note

* By default, you are logged on to the Intel
directory server when NetMeeting starts.

12
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With the Intel” Create & Share" Software you can Media Files

organize your media files into galleries. These media

Stillimages, video

files can include snapshots, videos, and audio files. clips, and audio
Incorporate these media files into the email postcards,  clips are often
video emails, or web pages that you create and send referred to as
to family and friends; play a virtual reality game that "media files".
puts you in the picture shooting hoops, popping

bubbles, or bouncing objects all over the screen; or set

up the camera to automatically take snapshots. Let

your own imagination guide you through the

possibilities.

What are ga"eries? Four galleries are

A gallery is a collection of video, audio, image, and

included as a part
of the software:

project files. Individual files can be a part of many * Main Gallery
galleries.  Clip Art
For instance, an image of the beach could be an * Auto-
i Snapshots
element of a vacation gallery and also a landscape _
* Projects

gallery.

From within a gallery you can:

Physically and logically copy and move media
files using drag-and-drop operations.

Open individual files by double-clicking on the
thumbnail.

Do simple editing of still images by double-
clicking on a still image thumbnail.

Sort media files according to the name, date, or
file type.

Print individual or all of the thumbnail still images
in a gallery.

13
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To view the full

gallery:

* Click Full
Gallery on the
Home Screen.

OR

* From the
Gallery menu,
choose View >
Full Gallery.

Did you know?

Open a gallery.

* Move between galleries by clicking on the button
next to Galleries list and selecting another gallery
from the list.

To get information about a media file’s properties:

In the gallery, click a file once to select it.

Click the lower right corner of the thumbnail and

the Properties dialog appears.

The properties differ according to the kind of media file

Click here to see
properties

4 Click OK when you have finished.

selected:
Still Image file Video file Audio file
* File Name * File Name » File Name
» File Location  File Location » File Location
« Last modified on » Last modified on * File Size
» File Size * File Size » Last modified on
» Resolution » Resolution (W x H) * Format
» Color Depth * Length in frames * Channels

¢ Format

* Length in seconds

* Frames per Second

» Channels

* Video Compression
used

* Audio Compression
used (if audio is
present)

» Sample Rate
« Sample Size

14
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To rename media files:

» On the Properties dialog, type the new file
name.

To edit a picture:
1 Double-click on a still image item in the gallery.
2 In the Edit Picture dialog, you can adjust the
brightness or contrast, rotate the image, or crop
the image.

Taking snapshots

Snapshots taken using your Intel” Deluxe PC Camera
can be organized into galleries, included in other
sources like electronic presentations, added to email
postcards, or included on your web pages.

To take a snapshot:
1 On the Home Screen, click Take Snapshot.

iaz: ]

2 When you have the image you want in the Live
View window, click the Snapshot button. The
snapshot appears in the Snapshot window.

3 Click Save in the Snapshot window. Your
snapshot is saved automatically to your default
gallery location.

Note

When renaming
media files, do
not change the
file’'s extension.

Note

To disable the

automatic save

feature:

1 From the File
menu, choose
Options.

2 Onthe Images
tab, select
Prompt for file
names and
locations
when saving
files.

15
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Note
You can also take
snapshots by

clicking the Intel”
Snapshot icon on
the desktop.
Some of the
features may
work differently.
For more
information on
Intel Snapshot,
consult the online
Help.

In order to ensure
that you can save

your video, the

recording size is

limited to
approximately
half of the disk
space available
when you start
recording.
Recording
automatically
stops when the
limit is reached.

16

Did you know?

You can click the right mouse button in the Live View
window and choose Options to:

Enable snapshot sounds.

Set a 5-second delay before taking the snapshot.
Sharpen the image.

Take larger snapshots.

Specify the file type of the snapshot.

Record a video

You can record live video using your Intel” Deluxe PC
Camera. These videos are stored in your galleries and
can be added to email postcards and home pages and
sent as video emails.

To record a video:

1

5

6

On the Home Screen, click Record Video.

To begin recording the video click Record.
When you have finished recording the video
click Stop.

Options:
To play back your video click Play.
To trim your video click Trim.

Click Save. Type a filename and select a gallery
from the Add to gallery list.
Click Save.

To trim the video:

1

2

Click the Trim button. Trim markers appear
below the video window.

Trim the video by moving the trim markers at
either end of the scale. The area outside the
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Trim markers will be gray.

- - It

Current position slider

Left trim marker Right trim marker

3 Move the trim markers by dragging them:
- Drag the left trim marker to the position you
want to mark as the beginning of the video.
- Drag the right trim marker to the position you
want to mark as the end of the video.
- Drag the trim markers to original positions to
undo trimming.

Did you know?

You can extract a still image from a previously
recorded video and save it in your gallery.

1 From the gallery, double-click the video file you

want to open.

2 Move the current position slider to the position in
the video you want to save.
Click Save Frame to take a frame shot.
The frame is saved automatically to your default
gallery location.

Hw

Note

By default, videos

are automatically

saved.

To disable the

automatic save

feature:

1 From the File
menu, choose
Options.

2 Onthe Record
Video tab,
select Prompt
for file names
and locations
when saving
files.

17
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Record audio

You can record audio files using the Intel” Audio
Recorder. You could use these files in a presentation
to narrate an important point, as an audio greeting in
an email postcard, or to add some life to a home page.

To record audio:

1

4
5

6

On the Home Screen, click Record Audio.

R

Click Record to begin recording, then speak into
your microphone.

Click Stop when you have finished recording
audio.

Click Play to review the recording.

Click Save. Type a filename and select a gallery
from the Add to gallery list.

Click Save.

For detailed information on recording audio files,
consult the online Help.
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Automatically taking snapshots

With Intel” Auto Snapshot you set up the Intel” Deluxe
PC Camera to take snapshots at specified intervals or

when motion is detected, and have the snapshots
saved to your hard drive, sent to an email address, or
posted to your home pages.

To take snapshots automatically:
1 On the Home Screen click Setup an Auto
Snapshot.

2 Choose the snapshot trigger.

The snapshot triggers are: when motion is
detected by the camera, or by a specified time
interval.

If you choose Motion Controlled snapshots,
determine the amount of motion the camera
should detect before taking a snapshot.

If you choose Timer Controlled snapshots, set
the time interval between snapshots. The timer
defaults to 15 minutes. The upper limit is 24
hours, 59 minutes, and 59 seconds.

3 Choose what to do with those snapshots.
You can save auto snapshots to disk, post auto
snapshots to a web page, or send auto
snapshots via email.

If you decide to save the snapshots to disk,
specify a location on the disk.

When Auto
Snapshot is set to
autodial and ICQ,
or a similar
application, is
waiting for an
Internet
connection,
problems can
occur. When Auto
Snapshot
connects, ICQ
senses the
connection and
tries to connect to
the ICQ server.
To avoid this
you can:

* Disable
Windows*
autodial

OR

* Disable the
ICQ NetDetect
Agent

19
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If you post auto snapshots to a web page, you
must specify an Internet Service Provider (ISP),
and depending on your ISP, your User name and
Password. For more details, see the Enable
Auto Dialing for Intel Auto Snapshot topic in the
online help.

If you send the snapshots via email, enter the
email address.

4 Add a caption to the snapshots. You can
optionally choose to add a specified text string to
each snapshot as well as the date and the time
of the snapshot. There is a default caption
provided.

5 Turn Intel Auto Snapshot ON. You must turn
Auto Snapshot On to have the camera take
automatic pictures according to your settings.

After the Intel Auto Snapshot settings have been
made, the application icon resides in your system tray.

» To turn it OFF you can click the right mouse
button on the icon and choose Off.

» To have the application quit, click the right mouse
button on the icon and choose EXxit.

When enabling the autodial feature many variables
can affect the success rate of automatically sending
your snapshots. Some of these variables include:

» Telephone connection

* ISP connection

* ISP’s server settings

We suggest checking the Auto Snapshot error log and
if needed exit and restart Auto Snapshot.

To check the error log:
1 In the system tray, click the Intel Auto Snapshot
icon.
2 Click Show Errors from the shortcut menu.
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Did you know?

The stand-alone version of Intel Auto Snapshot has
additional options including:

Saving an unlimited number of snapshots to your
disk.

Supplying a return email address for those
snapshots sent via email. This means the
recipient knows who sent them.

Adding the snapshot caption to the top or bottom
of the snapshot.

When taking pictures based on motion, you can
also specify how long to wait before taking
snapshots after the motion is detected.

Setting the timer to work 24 hours a day or only
during certain times.

To access the stand-alone version of Intel Auto
Snapshot:

1

2

3

Go to Start>Program>Intel Create & Share
Software>Intel Auto Snapshot. (Or, if you have
already set up the Intel Auto Snapshot, double-
click the icon in the system tray.)

To set up or change the settings, click
Configure.

Click OK when done.

To add an Auto
Snapshot
cutout to a web
page:

1 Click Add
New Item.

2 Choose Auto
Snapshot.

3 Position the
cutout on the
page.

When Intel Auto
Snapshot is set
up to send a
picture to the
home page, it
displays in the
added cutout.
See
Automatically
taking snapshots
for instructions
on setting up
Auto Snapshot.

21
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For more
information about
IntelY Video
Email, see the
online help

22

Create and send a quick video

email
1 On the Home screen, click Send a Video Email.

2 Record a video.
a Click Record New to activate the camera.
b Position the camera and focus on the
subject.
¢ Click Record.

Brmars T T Favrwan e Baas

3 Click Stop when you are done recording.

4  Enter your name or nickname in the From field.

5 Enter the email address of the recipient in the To
field.

6 Enter a short description in the Subject field.

7 Click Send it! to send the quick video email.

Did you know?

You can save the video you created for reuse.

To save the video:
1 From the File menu, choose Save Video.
2 Inthe Save As dialog, specify the filename, file
type, and gallery.
3 Click Save.



Using the Software

CHAPTER 3

Make and send an email post-
card

Suppose you are interested in sending a birthday
greeting to your children’s grandmother that includes
stills of your children, text, and an audio greeting from
the children to their grandmother.

To create the postcard

1

2
3

10

11

Take some snapshots of your children that you
want to include.

Save them in the desired gallery.

Have your children record an audio file and save
it to the desired gallery.

On the Home screen, click Send an Email
Postcard.

Click Create a new postcard.

Select the Birthday template from the Home &
Family category. Click Next to continue.

The cutouts already in the template can accept
text and video/image files. Drag one of the
snapshots you just took into the image cutout.
Double-click in the text cutout to add the birthday
greeting.

Add the newly recorded audio file to your
postcard by clicking the Insert menu and
choosing Audio Item. Choose the recorded
audio file from the gallery and click OK. Click
Next to continue.

Add text and grandma’s email address to the
back of the postcard. Click Next to continue.
Choose a method to send your postcard. You
can send it automatically or save the file to disk
and attach it to an email message. The saved
file can be found in the C:\POSTCARDS
directory.

To add another
cutout to the
postcard:

1 From the
Insert menu,
click Still
Image Item.

2 The new cutout
appears on the
postcard.

3 Position the
new cutout on
the postcard,
or resize
existing
cutouts before
moving the
new one.

See the online
help for
information about
overlapping
cutouts on an
email postcard.

23
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12 Click Preview to see how the card looks.

o

All the ne‘m

Ally, Sara, and Michael.

Inbo Cyoarta A Bhara™ ._F“' Sy .\‘lﬂl ik
13 Click Next to continue.
To close the 14 Congratulations! Your email postcard has been
Preview of the sent. Now you can choose to continue with the
postcard, click current postcard, create a new postcard, or
the Close (X) in return to the Home Screen.
the upper right 15 If you want to finish your postcard later or reuse
cormer. the postcard you created, create a postcard
project.

To create an email postcard project:

Note + From the File menu, choose Save Project.
Project files have

an. iep extension.

For more informa-
tion about email
postcard projects,
consult the online
help.

24
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Did you Know?

If you send your email postcard with its own viewer, the
recipient can save (extract) the media files (video, still
images, and audio) you have added to the postcard.

To save (extract) the files, the recipient needs to:
1 Click Extract on the viewer.
2 Click the item to extract.
3 Click Extract Selected Item.
4 In the Save As dialog, type a filename.
5 Click Save.

By default the media files in sent email postcards can'’t
be extracted.

To make it possible for the recipient to extract and
save the files:
1 From the File menu, choose Options
2 Onthe Postcard tab, select Allow recipient of
postcard to extract media from postcard.
3 Click OK.

Creating a home page

You can build a home page and other Web pages that
incorporate sounds, images, or videos.

When you complete your Web pages you can post
them to your Internet Service Provider. This collection
of Web pages is now your Web site.

To create and publish web pages:
1 Click Build a Home Page on the Home Screen

to bring up the Intel” Home Page Builder.

2 Choose Create a new home page.
3 Click the template that you want to use. Use the
scroll bars to view additional templates.

Note

If you are unsure
how to attach a
file to an email
message, check
your email
program’s online
help.

25
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Note:

Added pages
have the same
background as
the initial page,
but there are no
cutouts.

To add media
files to these
pages:

* Drag and drop
media files from
the gallery onto
the page.

Note:

When making a
text hyperlink,
select the text in
the cutout before
you make the link.
To select text:

» Click and drag
your mouse
over the target
text.
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Click Next.

Drag and drop audio files, video files, or still
images from the gallery to the cutouts on the
page. If necessary, size and position the cutouts
so they do not overlap.

Click Next.

Click Add Page to add more pages.

To automatically create links between all pages
on your site, choose the Link All Pages check
box.

Publish the site to a drive on your computer or to
your Internet Service Provider.

Did you know?

You can create links from an object on a page of your
Web site to any other page on the Internet. When a
reader views the page in a browser and clicks a link,
the browser opens the linked page.

To create a hyperlink:

1
2

Click the cutout for the item to link.

From the Cutout menu, select Add/Remove
Hyperlink. The HyperLink Properties dialog
appears.

From the Type of hyperLink list, choose the
type.

In the URL of hyperlink box, type the URL of the
hyperlink.

Click OK.



Using the Software CHAPTER 3

Using other devices

You can add new media to your galleries from attached
TWAIN-compliant devices such as a scanner or the

Intel” Deluxe PC Camera. Click Other Devices and
choose a device from the list.

Play a camera game

Put yourself in the action! These games let you interact
with virtual objects on your computer screen. Your

image is captured through the Intel” Deluxe PC
camera and displayed on the screen so you can pop
bubbles, bounce virtual objects around a room, create
kaleidoscopic patterns set to music, or play virtual
basketball. For more information on camera games,
consult the Reality Fusion online Help.

To start a camera game:
1 Click Play a PC camera game on the Home
screen.

-

2 Click the button of the game you wish to play.
3 When you're finished, press ESC.

Did you know?

To set general or specific options for the games:

1 From the Home Screen, click on Play a PC
camera game.

2 Click Configure games.

3 Choose General Options to set options for all of
the games, or choose Bouncelt2 or
PopTheBubbles2 to set up options specific to
these games.

4 Click OK.

TWAIN

A program that
lets you acquire
an image directly
into an
application.
TWAIN-compliant
devices include
scanners and
digital cameras.
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A Troubleshooting

See the Intel® Create & Share™ Software online Help for additional
troubleshooting information.

You can find other customer support information in the World Wide Web
Support section at the end of this manual.

General troubleshooting

Symptom Solution

The first time you start an application » Check that your computer has at a

that uses the camera, you receive the minimum a Pentium® processor,

“Camera is not available” message. 166MHz with MMX™ Technology
or higher.

If your computer does not have
MMX Technology, uninstall the
software and return the product for

a refund.
The audio is not recorded with the + Make sure your microphone and
video. speakers are connected properly.

+ To record audio, you must install a
sound card or have sound support
on your motherboard. If you
already have a sound card
installed, check the sound card
setup; make sure the software is
installed correctly. Check your
record and playback abilities.

Click Start> Programs> Acces-
sories> Entertainment> Sound
Recorder.

» Check the cable connections to
your sound card or motherboard.
Disconnect and reconnect your
cables.

Continued on next page...
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Troubleshooting

APPENDIX A

Symptom

Solution

Continued from previous page.

Your audio input source (micro-
phone, VCR, laserdisk) must be
connected to either Microphone or
Line In on your sound card.

» Check the audio level in the mixer
software; make sure your sources
are not muted.

» Check the sound card’s mixer
software; make sure the audio
input (Line In or Microphone) is
correctly set for the device you are
using. Also make sure the mixer
settings are set to Record.

+ Contact your sound card
manufacturer for help.

» Consult your system
documentation and sound card
documentation for detailed
instructions to run these checks.

The audio sounds too low or quiet

* Check the sound card’s mixer
software. Some software includes
an option for boosting microphone
gain. If the mixer software includes
this option, be sure that it is
selected

» Check the audio levels in the mixer
software; increase them as
necessary.

» Consult your computer and sound
card documentation for more
information.

Occasionally, the system appears
busy when working with camera
applications.

Wait a few seconds to see if video
continues normally. If your problem
persists, contact your computer man-
ufacturer or your display driver manu-
facturer to obtain updated drivers.
They are usually found on the manu-
facturer’s Web site.

Video display is green, distorted, is
taking random snapshots, or the live
video is corrupted by flashing hori-
zontal, colored lines.

A short term solution may be to
decrease the hardware acceleration
of your video display card. To adjust
the hardware acceleration:

Continued on next page...
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APPENDIX A

Troubleshooting

Symptom

Solution

Continued from previous page

1 Go to Start> Settings> Control
Panel.

2 Double-click the Display icon.
Click the Settings tab.

4 Click the Advanced Properties
button.

5 Click the Performance tab.

6 In the Graphics box, drag the
slider to the left to decrease the
Hardware Acceleration one
setting at a time.

7 Click Apply.
8 Click OK.

w

Repeat steps 1-8 if necessary.

Note: Decreasing the hardware
acceleration will affect your com-
puter’s performance and should only
be used as a short term solution.

As a long term solution, obtain the lat-
est video card drivers from the display
card manufacturer. Most manufactur-
ers provide the most current drivers
available on their Web site. See the
video display card documentation for
more information.

When viewing live video, the Live
View area of the application is solid
black, blue, or green.

» Make sure the camera cable is
securely connected.

Your USB hub power is not working
and you receive the message:

“The hub does not have enough
power available to operate the Intel
PC Camera.

* Ensure that the hub is a powered
hub and is connected to an
electrical outlet for power.

OR

» Use a port directly on the back of
your PC to use the camera.

30




Troubleshooting

APPENDIX

A

Symptom

Solution

When using Microsoft Windows Net-
Meeting, my video does not appear in
the video window even after | click the
video button.

NetMeeting may be using a video
device other than the Intel PC Cam-
era.

To ensure that you are using the Intel
PC camera:

1 On the NetMeeting Tools menu,
choose Options.

2 On the Video tab, in the Video
camera properties list, select
Intel USB Camera lll.

3 Click OK
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B Technical Specifications

The following are the technical specifications for the IntelC Deluxe PC

Camera’.

Characteristics

Specification

Image Sensor

Progressive scan CCD, 640 x 480

Image Format

YUV 4:2:0

Interface

Universal Serial Bus (Rev. 1.1)

Special Feature

Flicker Free Operation (under 50 Hz/60 Hz
fluorescent lighting)

Maximum No. of Pixels

640 x 480

Resolutions (native)

640 x 480, 320 x 240, 160 x 120

Additional camera
(scaled) resolutions
available

352 x 288, 176 x 144, 240 x 180, 240 x 176

Snapshot image
resolution

640 x 480 maximum

Video image resolution

640 x 480 maximum

Frame rate?

30fps@160 x 120, 30fps@QCIF (176 x
144), 30fps@CIF (352 x 288), 5 -

15fps@VGA (640 x 480)
Min. lllumination 20 Lux
Gamma 0.45

White Balance

Automatic or manual control

Pan - Mechanical 360 deg
Lens F2.3
Tilt - Mechanical +/- 22.5 deg
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Technical Specifications APPENDIXB

Characteristics Specification

Connector Series A type of USB receptacle
Dimensions 66.0 mm x 45.0 mm x 95.4 mm
Safety Standards UL, cUL

EMC Standards FCC (B), CE, VCCI

1 For use only with UL listed PC.
2 Video capture and playback frame rate and resolution depend on many factors,
including video source, system configuration, and software used.
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System Requirements

System requirements

To install the Intel”Create & Shared Software, your system must meet
the following minimum requirements:

PC with 166 MHz Intel 0 Pentium® processor with MMX™
Technology or an Intel® Celeron processor or better

Available Universal Serial Bus (USB) Port

Windows™ 98, Windows™ 98 Second Edition(SE), Windows*
Millennium Edition

32 MB RAM

800x600 display, 16-bit color (32-bit color is recommended for
better image quality)

150 MB available hard disk space
4X CD-ROM drive
Windows compatible sound system with speakers and microphone

Internet Service Provider and 28.8 Kbps or higher modem to make
video phone calls over the Internet

Netscape Navigator* 4.0 or Microsoft Internet Explorer* 4.0 or
higher

The recommended system requirements for Reality Fusion Camera
Games are:
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Windows™ 98, Windows* 98 Second Edition (SE), Windows*
Millennium Edition
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Intel Camera Limited Warranty
Limited Warranty.

Intel warrants that the Camera Hardware Product if properly used and installed, and the CD-
ROM on which the accompanying software is provided, will be free from defects in material
and workmanship for a period of one (1) year after the date of purchase.

If the Camera Hardware Product or the CD-ROM which is the subject of this Limited
Warranty is defective in material or workmanship during the warranty period, Intel, at its
option, will:

* REPAIR the Camera Hardware Product by means of hardware and/or software; OR

* REPLACE the Camera Hardware Product or CD-ROM with a replacement Camera
Hardware Product or CD-ROM; OR,

» If Intel is unable to repair or replace the Camera Hardware Product or CD-ROM,
REFUND the then-current value of the Camera Hardware Product or CD-ROM.

THIS LIMITED WARRANTY, AND ANY IMPLIED WARRANTIES THAT MAY EXIST UNDER
STATE LAW, APPLY ONLY TO THE ORIGINAL PURCHASER AND LAST ONLY FOR AS
LONG AS SUCH PURCHASER CONTINUES TO OWN THE CAMERA HARDWARE
PRODUCT AND CD-ROM.

Extent of Limited Warranty.

This warranty does NOT cover the performance or functionality of any computer software
included in the package with the Camera Hardware Product, this warranty only covers
defects in the CD-ROM media such as a broken CD-ROM or a defect in the CD-ROM that
would prevent the CD-ROM from being read by your personal computer’s CD-ROM drive.
INTEL MAKES NO WARRANTY THAT THE SOFTWARE PROVIDED WITH THIS CAMERA
HARDWARE PRODUCT WILL FUNCTION WITHOUT INTERRUPTION OR OTHERWISE
BE FREE OF ANOMALIES, ERRORS OR "BUGS". INTEL MAKES NO WARRANTY WITH
REGARD TO ANY SOFTWARE PROVIDED WITH THIS CAMERA HARDWARE
PRODUCT UNLESS SPECIFICALLY SET FORTH OTHERWISE IN A LICENSE
AGREEMENT ACCOMPANYING SUCH SOFTWARE.

This limited warranty does not cover any costs relating to removal or replacement of any
Camera Hardware Product, CD-ROM, or software installed on your computer.

This limited warranty does not cover damages due to external causes, including accident,
problems with electrical power, usage not in accordance with product instructions, misuse,
neglect, alteration, repair, or improper installation.

How To Be Eligible For Warranty Coverage.

In order to be eligible for warranty coverage, You MUST register the Camera Hardware
Product with Intel within thirty (30) days of purchase. Registration can be completed by
following the instructions in the "Register Online" program that is included on the CD-ROM
that is included in the package with the Camera Hardware Product.

How to Obtain Warranty Service.

To obtain warranty service, you must return the Camera Hardware Product to Intel. Before
returning the Camera Hardware Product to Intel, you must contact Intel’s Customer Support
Group:

North America only:
1-916-377-7000
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If you obtain warranty service from Intel, upon Intel’s verification that the Camera Hardware
Product or CD-ROM may be defective, you will be issued a Return Material Authorization
(RMA). When you return the Camera Hardware Product and CD-ROM to Intel, you must
include the RMA number on the outside of the package. Intel will not accept any returned
Camera Hardware Product or CD-ROM that has no RMA number on the package.

If you return the Camera Hardware Product and/or CD-ROM to Intel, you must assume the
risk of damage or loss during shipping. You must use the original packaging or the
equivalent, and you must pay the postage.

Intel may elect to replace or repair the Camera Hardware Product and/or CD-ROM with
either a new or reconditioned product. The returned product shall become Intel’s property on
receipt by Intel.

The replacement Camera Hardware Product and/or CD-ROM is warranted under this written
warranty and is subject to the same limitations and exclusions for the remainder of the
original warranty period or ninety (90) days, whichever is longer.

WARRANTY LIMITATIONS AND EXCLUSIONS.

THESE WARRANTIES REPLACE ALL OTHER WARRANTIES, EXPRESS OR IMPLIED
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. INTEL MAKES NO
EXPRESS WARRANTIES BEYOND THOSE STATED HERE. INTEL DISCLAIMS ALL
OTHER WARRANTIES, EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION,
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES SO THIS LIMITATION MAY NOT APPLY TO YOU.

ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED IN DURATION TO THE
LIMITED WARRANTY PERIOD. NO WARRANTIES APPLY AFTER THAT PERIOD. SOME
STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY
LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU.

LIMITATIONS OF LIABILITY.

INTEL'S RESPONSIBILITY UNDER THIS, OR ANY OTHER WARRANTY, IMPLIED OR
EXPRESS, IS LIMITED TO REPAIR, REPLACEMENT OR REFUND, AS SET FORTH
ABOVE. THESE REMEDIES ARE THE SOLE AND EXCLUSIVE REMEDIES FOR ANY
BREACH OF WARRANTY. INTEL IS NOT RESPONSIBLE FOR DIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF
WARRANTY OR UNDER ANY OTHER LEGAL THEORY INCLUDING, BUT NOT LIMITED
TO, LOST PROFITS, DOWNTIME, GOODWILL, DAMAGE TO OR REPLACEMENT OF
EQUIPMENT AND PROPERTY, AND ANY COSTS OF RECOVERING,
REPROGRAMMING, OR REPRODUCING ANY PROGRAM OR DATA STORED IN OR
USED WITH A SYSTEM CONTAINING YOUR CAMERA HARDWARE PRODUCT CD-
ROM OR ACCOMPANYING SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY
NOT APPLY TO YOU.

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY
ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE.
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FCC Compliance Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the two following

conditions:

1.  This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may
cause undesired operations.

The board has been tested and verified to be within the energy emission limits for Class B
digital devices as defined in Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential situation. This board
generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
Installed correctly, it probably will not interfere with your radio or TV. However, we do not
guarantee the absence of interference.

If you modify the board in any way, without getting approval from Intel Corporation, your
board may violate FCC regulations. Violation of FCC regulations may cause the FCC to void
your right to use the modified board. Only peripherals (computer input/output devices,
terminals, printers, etc.) certified to comply with the Class B limits may be attached to the
computer containing the board. Operations with non-certified peripherals is likely to result in
interference with radio and TV reception. NOTE: Use only shielded, grounded cables.

If you suspect this board is causing interference, turn your computer on and off while your
radio or TV is showing interference. If the interference disappears when you turn the
computer off and reappears when you turn the computer on, something in the computer is
causing interference.

To reduce interference, try these suggestions:

* Change the direction of the radio or TV antenna.

* Move the computer or the radio or TV. For example, if the computer is to the right of
the TV, move it to the left of the TV. Or, move the computer farther away from the
radio or TV.

* Plug the computer into a different outlet. Don’t plug your radio or TV into the same
circuit as your computer.

« Ensure that all expansion slots (on the back or side of the computer) are covered.
Also, ensure that all metal retaining brackets are tightly attached to the computer.

If these suggestions don’t help, consult your computer dealer or an experienced radio/TV
technician for more suggestions.

Industry Canada’s Compliance Statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing
Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le
matériel brouilleur du Canada.
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Intel World Wide Support

You can reach Intel’s automated support services 24 hours a day, every day at no charge. The services
contain the most up-to-date information about Intel products. You can access installation instructions,
troubleshooting information, and general product information.

Intel Help Files: View the online help in each application and the README files included with the product
for detailed information on product features and functions.

If you don’t have access to automated services: Contact your local retailer or call one of Intel’s
Customer Support Centers.

World Wide Web
Customer Support:

http://support.intel.com/support/createshare/camerapack/

Intel Customer Support Technicians

For 90 days you are entitled to speak to our technical support professionals with no service charge,
however, standard phone charges will apply. After your initial 90 days of unlimited technical phone
support, you can pay per incident using a credit card.

Important: At the time of your call, please be at your computer and have your serial number from your
camera ready. Look for the serial number on the label on the bottom of the camera or on the camera
cable. Support options are subject to change without notice.

Country Telephone Number

North America 1-916-377-7000

United Kingdom +44(0) 870 607 2439

France +33(0) 14191 8529

Germany +49(0) 69 9509 6099

Italy +39(0) 2 696 33276

Spain +34(0) 91 377 8166

Australia 1-800-881-001 after the tone dial 877-858-6544
New Zealand 000-911 after the tone dial 877-858-6544
Malaysia 1-800-80-0011 after the tone dial 877-858-6544
Singapore 800-0111-111 after the tone dial 877-858-6544
India 000-117 after the tone dial 877-858-6544
Japan 03-5350-8866

Hong Kong 800-96-1111 after the tone dial 877-858-6544

If your location is not listed above, contact your local dealer/distributor for technical
assistance.

Spare parts and additional accessories are available for your camera pack. Please refer to http:/
support.intel.com/support/createshare/camerapack/1839.htm.
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